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What’s New? 

Platform Reference Model VMs 
Supported Images 
 
The current CML 1.1 release supports the following reference images: 
 

Image  Bundled ( Yes / No) 
NEW IOSv - 15.5(3)M image Yes 
NEW IOSvL2 - 15.2.(4.0.63)E image Yes 
NEW IOSXRv - 5.3.1 CCO demo image Yes 
NEW CSR1000v - 3.16 XE-based demo image Yes 
NEW Ubuntu 14.04.2LTS Cloud-init Yes 
NEW Unmanaged Switch   Yes 
NEW NX-OSv 7.2.0 (ZD 120) Experimental Image No. Available on CML FileExchange 
NEW ASAv 9.4.1 No. Available on CML FileExchange 

 
 
Virtual Machine Memory Requirement 
 

Image  Memory Requirement (MB) 
NEW IOSv - 15.5(3)M image 512 
NEW IOSvL2 - 15.2.(4.0.63)E image 768  
NEW IOSXRv - 5.3.1 CCO demo image 3072 
NEW CSR1000v - 3.16 XE-based demo image 3072 
NEW Ubuntu 14.04.2LTS Cloud-init 2048Mb 
NEW NX-OSv 7.2.0 (ZD 120) – Experimental Image 3072 
NEW ASAv 9.4.1 2048  
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New Features 
• IOSvL2 15.2.(4.0.63)E - A new IOSv-based Layer 2 switch virtual machine image is now available 

and bundled with CML. The IOSvL2 image is considered a full virtual machine and therefore 
counts against the Cisco node count limit. If you do not wish to use the IOSvL2 virtual machine, 
the 'unmanaged switch' icon is an alternative Layer 2 switch element. The IOSvL2 image 
supports the following capabilities: 

o Layer 2 switch forwarding (auto-configured)  
o Switchport (auto- configured)  
o 802.1q trunk, 802.1q VLANS (auto- configured)  
o Spanning Tree (auto- configured)  
o Port-Channel  
o 802.1x pass-through  
o Port-ACLs  
o Dynamic ARP Inspection  
o DHCP Snooping 
o IP device tracking 
o Switched Virtual Interfaces 
o Layer-3 forwarding over SVIs 
o Routing protocol support 
o Vlan Access Maps (VACLs / access control lists for vlans) 
o ACL functionality for both layer2 and layer3 protocol packets 
o Dynamic Trunking Protocol support 
o Switchport protected mode 
o Port mirroring (SPAN) is NOT supported 
o Private VLANS are NOT supported 

• IOSvL2 ANK Configuration Support / VLAN Support – CML now supports the IOSvL2 image. You 
can use the Build Initial Configurations tool to create the basic configuration required to 
configure the IOSvL2 instance type. By default, interfaces from routers or servers connected to 
the IOSvL2 instance will be placed into VLAN 2. Multiple IOSvL2 instances can be connected to 
each other, with .1Q Trunk port configuration being applied.  

Users can select the router/server, select its interface from the Node Editor view and then set 
the VLAN value in the Interface Properties/AutoNetkit field. 
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In the example shown, the interface GI0/1 on IOSV-3 is placed into VLAN 20. The configuration that 
will be built for IOSv_l2-2 places the interface GI 0/2 on IOSv_l2-2 into VLAN20. Configuration 
Extraction support is also provided for the IOSvL2 instance type. 

• ASAv 9.4.1 – CML now supports Adaptive Security Appliance virtual machine (ASA1000v). Note 
that in order to run the ASAv VM, the CPU of your server must support SSE3 flags. Intel CPUs are 
included in this support.  

o ASAv goes through a double-boot before becoming active. This is normal and expected.  
o ASAv Basic Configuration Support.  You can use the Build Initial Configurations tool to 

create the basic configuration required to configure the ASAv. Configuration Extraction 
support is also provided for the ASAv instance type. 

• Unmanaged Switch replaces the Multipoint Connector - The multipoint connector has been 
retired and replaced by the new Unmanaged Switch subtype. 
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The unmanaged switch operates in the same manner as the multipoint connector in that 
multiple devices connected to the same unmanaged switch operate as if they were all in the 
same layer-3 broadcast domain. When the Build Initial Configurations tool is used, devices 
connected to the unmanaged switch are placed in the same subnet. 
 
A maximum of 15 interfaces can be connected to a single unmanaged switch instance. However, 
you are able to connect multiple unmanaged switch instances to each other to enable larger 
numbers of devices to be connected to, what appears to be, a single broadcast domain. 
 
In the following diagram, two unmanaged switch instances are connected, such that the devices 
on the right-hand side of the diagram are in the same broadcast domain and layer-3 subnet as 
those on the left-hand side of the diagram. 

 

If you have existing .virl files that have a multipoint connector present, when you open the file in 
CML 1.1, the multipoint connectors appear with 'problem' markers as per the following 
example. 
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The Problems view lists the errors as per the example above. In order to be able to launch your 
simulation, you need to convert the Multipoint connector to an unmanaged switch. This is done 
by right clicking one of the error reports and selecting Quick Fix from the drop-down menu. On 
the Quick Fix dialog box, you can then select all of the 'problems' to be fixed and click Finish to 
update your topology file. 
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Your topology will now be updated to use Unmanaged Switches instead of the older Multipoint 
connector. 

 

• Interface State Control (Link down/Link up) When a simulation is running, you are can change 
the state of the network interface (down/up). Note: this does not change the state of the 
interface on the virtual machine but rather changes the state of the underlying communications 
infrastructure. In order to change the interface state, using a web browser, connect to 
'http://<ip address of your CML server>' and log in to the User Workspace Management 
interface using the username and password (such as guest/guest) under which you started your 
simulation. In the Overview page, select the active session. 
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The Interfaces table is displayed and you can select Update Admin State from the Options 
column. 

 

You are asked to confirm that you wish to change the interface state before the action is 
performed. 

Note: The state of the interface is NOT captured when a configuration extraction is performed, 
since this is gathering the state of the virtual machines, not the underlying communications 
infrastructure. 

• MPLS LDP Support - Users are now able to explicitly enable LDP on a per-node basis using the 
AutoNetkit MPLS LDP attribute. Setting this value and running the Build Initial configurations 
tool results in LDP being enabled on all interfaces connecting to another router running MPLS 
LDP.  

• IPv6 Auto Configuration for Linux Servers - Linux servers are now automatically configured with 
IPv6 addresses and route entries when the IPv6 address family is enabled.  

• LXC Jumphost Functionality - The LinuX container is now the default 'jumphost' - providing a 
lightweight Linux server which provides a common access point into your simulation as well as 
providing the gateway for SSH access to your virtual machines. 
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If you wish to use a full-blown Linux Virtual Machine instead of the LinuX container, deselect the 
field shown above. A Linux VM will be spun up when the simulation is started and the Management 
network is set to Shared Flat Network or Private Project Network. 

• Exclude from Launch markers - users are able to mark a node so that is it excluded from the 
simulation launch. This means that the selected node(s) will not be started when the rest of the 
simulation is launched. Excluded nodes can be launched later if required. The new functionality 
provided means that excluded nodes are marked with a small icon indicating that the node will not 
be started at launch. The icon display is controlled by the Show Topology Labels button on the 
toolbar. 

 

 

• Microsoft Visio VSDX Import Support - The CML client GUI now offers Microsoft Visio .VSDX file 
import functionality. Care is required with this function. The import functionality is designed to 
work with the Cisco Network symbol templates and will not guarantee successful import from 
any other symbol template type. The purpose of the import functionality is to convert a .vsdx 
topology file that contains Cisco Symbol types and point to point links into a topology diagram. 
Elements such as textual labels may not be converted during the import process. 

• SVG Export Support - The CML client GUI now offers SVG (Scaled Vector Graphic) export 
capability. Using this functionality, you can convert a CML .virl file into a SVG diagram. This then 
can be imported into other diagramming tools such as Microsoft Visio. 

• Topology Visualization Engine Upgrade - The NeXT-UI visualization engine has been upgraded 
providing an updated look and feel to the AutoNetkit visualization diagrams as shown. 
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• Visualization Search and Query - The new Search field in the AutoNetkit visualization view 

enables the user to create text-based queries in order to filter elements. The query scope is 
based on the view selected (for example, phy, layer2, igp, etc.) The query engine will provide 
the user with a list of valid options based on the topology as per the following example. 

 
 

• Default node types in Palette view - The nodes Palette view now offers you the choice of IOSv, 
IOSvL2, Server and Unmanaged Switch types as standard. You no longer need to retrieve 
subtypes from the CML server when you start the CML client GUI. However, the function File -> 
Preferences -> Node Subtypes ->Fetch from Server is still required to show the XRv and 
CSR1000v demo images or if you have added further new subtypes to your CML server. 

• LinuX Container as Jumphost - When designing your topology, the CML client GUI now offers a 
new option under the Properties -> Topology -> Management Network drop-down list. If you 
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choose this option, instead of creating a full Linux Server VM to provide a central access point 
into your topology, a per-simulation LXC is created. The LXC is automatically connected into the 
OOB management network to which all VMs in your simulation are connected, enabling you to 
connect into each VM via its management Ethernet port, removing the need to use the Console 
port connection method. 
 
The LXC is operational while your simulation is active and terminates when your simulation is 
stopped. The LXC uses a significantly smaller memory footprint that the Linux Server VM. 
 
The LXC automatically gets an IP address on the FLAT network.

 

It is accessed via SSH ONLY (no telnet support) and can be accessed via a right-click. 
 

 
The LXC can also be accessed directly using an external SSH client using the External IP 
address shown or it can be reached via your CML server using the External Port value 
displayed (ssh <virl username>@<virl server ip> -p <External Port>), for example 'ssh -p 
37546 guest@10.195.90.1'. 
Note: The password to access the LXC is set to your CML username, for example the 
default username 'guest' has the password 'guest'. 

• Static Port Assignment to the LinuX Container - By default, if the option is selected, the CML 
system will assign random port to SSH port access to the LXC. You can statically define this by 
setting an extension on your topology. Open your topology and select the Properties tab. In the 
Properties tab, click Extensions and click the + symbol. Create a Key called' lxc.host.tcp_port' 
with the Value: <port number> as shown. 
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As a result when the LXC is started, it is bound to the TCP port that you specified. 

• Jumphost (Linux VM) SSH Port Access - When designing your topology, a Linux server VM is 
launched if you have the Properties -> Topology -> Management Network drop-down- list  set 
to either Shared Flat Network or Private Project Network.  The Linux server VM is now 
reachable using an external SSH client using the External IP address shown or it can be reached 
via your CML server using the External Port value displayed (ssh <cml username>@<cml server 
ip> -p <External Port>). 

 
In this example, 'ssh -p 56738 guest@10.195.90.1'. 
Note: The password to access the Jumphost is set to your CML username, for example the 
default username 'guest' has the password 'guest'. 

• Node SSH Access - If you have enabled the LXC (described previously), you now have the ability 
to start a SSH session which will connect into the node via the LXC. This access method makes 
use of SSH to the LXC then telnet from the LXC to the nodes running inside the simulation. This 
does not use the console port of the nodes and is a) more reliable and b) faster to use. 

 
The example above shows an active simulation with the Private Simulation Network option 
selected. The IOSXRv instance now offers the SSH connection method. 

• Perform Simulation Actions on Multiple Nodes - You can now select multiple nodes from the 
Simulation view and perform numerous operations on the selected. This means that you can 
open connections to node, stop and start nodes through a single action. 
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• Simulation Expiry function - The Launch Simulation tool on the CML client GUI toolbar now 
offers a drop-down menu option to start a simulation and to start a simulation with a specified 
expiry time. The timer value is displayed in the Simulation perspective when a simulation is 
running. A pop-up message will appear 10 minutes before the expiration time, reminding the 
user that the simulation is due to shut down. At the expiry time, the simulation will be 
terminated with a message reported in the console log. Note: the time reported in the console 
log is that of the CML server and does not take into account the CML client GUI’s local time.  

• Linux Server Snapshot Support - In a simulation with a Linux server present, you are now able to 
take a snapshot of the server's disk content. To do this, log in as a user (not as uwmadmin) into 
the User Workspace Management interface. Select your running simulation on the Overview 
page (under sessions). You will now see a list of active VMs. Select your Linux server and under 
the Options drop-down menu, click Create Snapshot. This creates a new user-specific disk 
image which can then be selected from the Image list in the CML client GUI for use in other 
simulation sessions. 

 

• UWM Project and User Export and Import Functionality - This feature enables you to take 
projects and users from one version of CML and import them into future versions. Log in to the 
User Workspace Management interface as 'uwmadmin' and choose Projects. You can then 
export the current project and users settings either as TSV or JSON format. The import function 
will read in the TSV or JSON formatted content. You are able to make changes manually in the 
file and import.  

• Multi-IGP Support in AutoNetkit - You can now specify the IGP to be configured by AutoNetkit 
on a per-node basis. You are able to set the IGP at the topology-level but then override this on a 
per-node basis by setting the IGP under the node's AutoNetkit -> IGP properties. This enables 
you to set EIGRP on all nodes within one AS, OSPF on all nodes in another AS. Note:  Automatic 
redistribution of routes from one IGP to another is not offered.  

• SNAT Gateway IP Address Reported in the UWM - The Connectivity tab in the User Workspace 
Management interface now reports the Internal and External IP addresses used for L3 SNAT 
connections, making it easier to identify the default gateway IP address that you should be 
using. For VMs inside of the simulation, the network SNAT gateway IP is the default gateway 
address that should be used for external connectivity.  

• Static IP Address Operations - Users are able to specify a static IP address which can be applied 
to either the VM's management interface or to an interface connected to a Flat network 
connector. The user must have admin set as a role under their user profile in the User 
Workspace Management interface. In the CML client GUI, to set a static IP address on the 
management interface, select the node. In the Properties view, choose Extensions and click the 
+ symbol. The Key field must be set to 'static_ip', the Value field is then set with your required 
IPv4 address (no subnet mask is required). When the simulation is spun up, the IP address 
specified will be applied to the management interface. the CML client GUI, to set a static IP 
address on the Flat interface design your network and add an L2 External (Flat) object to the 
design. Create a connection from your node to the L2 External (Flat) object. Select the L2 
External (Flat) object. In the Properties view, choose Extensions and click the + symbol. The Key 
field must be set to 'static_ip', the Value field is then set with your required IPv4 address (no 
subnet mask is required). When the simulation is spun up, the IP address specified will be 
applied to the interface of the node connected to the L2 External (Flat) object.  



    
   

Release Notes for Cisco Modeling Labs version 1.1   
14 

• L2TPv3 External Connectivity - Using a combination of the L2 External (Flat) network object, 
IOSv instances and the External Router object, AutoNetkit is able to configure an L2TPv3 tunnel, 
allowing you to connect simulations to remote devices in a transparent manner.  

• Large MTU Support - You are now able to pass packets up to 9100 bytes in size across link with 
no fragmentation.  

• IPv4/IPv6 Node Display on Canvas - A new Show Topology Labels tool is available in the CML 
client GUI, next to the Build Initial Configurations tool. When enabled, IPv4 or IPv6 loopback 
addresses configured either manually or by AutoNetkit will be displayed on the topology 
diagram.  

 

 

• Parallel Link Support in AutoNetkit - AutoNetkit will now create appropriate IP addressing, IGP 
and BGP configurations taking into account the presence of parallel links.  

• Partial Configuration Scrape/ Improved Configuration Extract Function - When a configuration 
extraction process encounters problems with a particular node, instead of aborting the 
extraction process, the failing node is identified and reported. The extraction process will 
continue and will return the collected configurations to you.  

• Full VM Renaming Capability - Users are now able to set the host name of their CML VM to one 
of their own choice via the hostname field in the settings.ini file. This should be done at 
installation time.  

• Password Change Support - You can now set the passwords used within the CML system by 
setting values in the setting.ini file for 'uwmadmin_password', 'password' (used by Openstack) 
and 'mysql_password'. Note: The password must be set using only alphanumeric characters. 

• Server Statistics Report - A new Statistics page on the User Workspace Management interface 
provides information on the simulations being run on your server. 
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• Partial Simulation Start Function - Users can now select nodes and mark them to be excluded 
from the simulation start with the introduction of a new field in the Node Properties view in the 
CML client GUI. 
 

• Custom Configuration Block - Users can now paste valid configuration content into specific 
blocks of the configuration. This allows you to add additional configuration lines alongside those 
created by AutoNetkit. 

 

• GRE Tunnel Support - Users can now create configurations for v4/v6 GRE Tunnels. Ideal for 
connecting to external devices or other simulations.  

 

• IPv6 Address Controls in AutoNetkit - User can now modify and assign v6 address pools used 
for infrastructure, loopbacks, and VRF pools. 

 

• Static IP Address Assignment when Using FLAT Connectors – A 'static_ip' extension can be 
applied to FLAT connectors to set the v4 addresses which will be used on a VM. 

 

• New 'Jump page Menu – A new CML server landing page is now available at <your CML VM 
server ip address>. 

 

• OpenStack Horizon Interface Enabled by Default – An OpenStack Horizon interface is now 
available. However, it is a read-only interface and as such you cannot make any updates via this 
interface. It only works for the uwmadmin user. 

 

• New Connectivity Option in the User Workspace Management Interface - This is for external IP 
address information reporting and management, allowing managers to allocate a fixed IP 
address for the jumphost of a project. 

 

• Jumphost can be accessed using your CML username and password (for example, 
guest/guest.) 

 

• Jumphost can be allocated to a fixed IP address. 
 

• VNC service is enabled by default. 
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Changes 
 
New: The VM now requires 5 network interfaces: 

• eth0 - used for accessing the CML VM  
• eth1 - used for FLAT networking - map to 'Flat'  
• eth2 - used for 2nd FLAT networking interface - map to 'Flat1'  
• eth3 - used for SNAT networking as per previous release - map to 'SNAT'  
• eth4 - used by OpenStack - map to 'INT'  

Caution: You need to make specific changes in your ESXi host to support these networks.  Two new 
port-groups must be created called 'Flat1' and 'INT'.  If you deploy the OVA before creating these new 
port-groups then ESXi will map the VIRL interfaces eth2 and eth5 to 'VM Network' and this has been 
shown to cause instability once CML is started.   
 

• Communication ports (web services) between client and server have changed in order to avoid 
clashes with other software: 

 
o CML web services port was 8080; it is now 19399. 
o CML User Workspace Management port was 808; it is now 19400. 
o ANK web visualization port was 8000; it is now 19401. 

  
These are the new default ports as you install/upgrade the client. You can update these 
manually by using the CML client GUI, if required. 

 

 
 

Note: The AutoNetkit visualization port must be set to port 19401. Under File -> Preferences -> 
Web Services -> AutoNetkit Visualization update the Visualization port field as shown. 
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• CML Client GUI New Toolbar and Menu Layout - The toolbar and menu layout has been simplified and 
improved. 

 
 

The intent has been to provide users with the key functions directly on the toolbar, 
moving less-frequently used functionality to the menu bar. 

• New AutoNetkit Tool - A new high-definition icon has been introduced with the tooltip Build 
Initial Configurations. 

 
• VMWare ESXi 5.1/5.5 

Your ESXi server must have Intel CPUs with VT-X support. AMD processors will not work. Confirm 
what kind of CPU you have before attempting your CML installation. 

Your ESXi server must have these minimum patch levels listed in order to run. 

• ESXi 5.1U2 (Build 1483097) 
• ESXi 5.5U1 (Build 1623387) 
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• ESXi 6.0 (Build 2494585) 
 

Verify that you are using vSphere Client v5.5 Update 2 (Build 1993072) or a later before 
deploying CML.  Failure to use the minimum version will result in a failed deployment that will 
create an error of nested virtualization not supported. 

Note: VMWare ESXi 5.0 is no longer supported. 

• Unmanaged Switch Replaces the Multipoint Connector - The multipoint connector has been 
retired and replaced by the new unmanaged switch subtype. See the New Features section for a 
full description. 

• Ubuntu Linux Server 

• The Ubuntu Host uses Cloud-init for Configuration - AutoNetkit is required to be run in order to 
build the base configuration. 
 
In the CML client GUI, you can set a Server username and can pass in an optional SSH public key 
as shown: 

 

 
 
 
For serial and telnet access via out-of-band interfaces, use the defined username plus the 
password 'cisco'. ANK provides a default user 'cisco' with password 'cisco' in addition to a 
user-defined username and key. If you are using ANK then you can log in as  'ssh cisco@<ip 
address of Ubuntu server>' - it takes time to log in so be patient. 
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Only if you need external access to a .1q Vlan (OOB network or External data-plane) on the 
interface in the Ubuntu VM, install Vlan support 

  
sudo apt-get install vlan 

  
Then load the 8021q module into the kernel. 
 
sudo modprobe 8021q 
  
Here is a set of example entries added to the /etc/network/interfaces file that enable Vlan10 on 
eth1: 

  
auto eth1 
auto vlan10 
iface vlan10 inet static 
address 172.16.1.10 
netmask 255.255.255.0 
network 172.16.1.0 
broadcast 172.16.1.255 
gateway 172.16.1.2 
vlan_raw_device eth1 
  
 
The configuration above enables the eth1 interface and then configures Vlan10. 
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Caveats 
IOSv 15.5(3)M - running image memory footprint increases to 330Mb from ~320Mb. 

 Symptom: IOSv 15.5(23)M - On boot-up the following message may be observed. 

%SYS-3-CPUHOG: Task is running for (1997)msecs, more than (2000)msecs (0/0),process = TTY 
Background. 

-Traceback= 114ECF8z 130425z 15E20Ez 15DF30z 15DD3Dz 157D75z 158A2Bz 1589BFz 159B67z 
153672z 3C9740Az 3C868CEz 3C89BEFz 5125F91z 491D86Cz 492E540z - Process "Crypto CA", CPU 
hog, PC 0x00157D2C 

 Synopsis: This issue is cosmetic and can be ignored. 

Solution: Can be ignored. 

Symptom: Quick Fix failing with a String index out of range: error. (VIRLDEV-958) 

Synopsis: For a node interface with a missing ID attribute <not specified>, selecting Quick Fix in the 
Problems tab to fix the problem returns a String index out of range: error.  

 

Solution: None currently. As a workaround, go back and specify the interface name for the node. 
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 Symptom: Loss of Cisco IOSvL2 packets when using PAgP protocol. (VIRLDEV-1578) 

Synopsis: Cisco IOSvL2 packets are getting lost during channel forming negotiations when using the 
PAgP protocol. The number of packets received does not match the number of packets sent. 

Solution: None Currently. 

 Symptom: Uppercase and special characters are not supported for use in the settings.ini file when 
updating the hostname and uwmadmin/OpenStack/MySQL passwords. (VIRLDEV-1785) 

Synopsis: When uppercase and special characters are used in the settings.ini file for updating the 
hostname and uwmadmin/OpenStack/MySQL passwords, a connection error occurs. 

Solution: Do not use Upper Case or Special Characters. 

 Symptom: ISO install returns a black screen when the second option (install virl directly) is 
selected. (VIRLDEV-1812) 

Synopsis: When doing an ISO install on the UCS B-series, choosing the option install virl directly 
returns a black screen that persists and you cannot move forward with the install. 

Solution: None currently. As a workaround choose the first option. 

 Symptom: Performing Group to Site/Ungroup Site actions multiple times throws a NullPointer 
exception.  

Synopsis: When the actions Group to Site and Ungroup Site are performed multiple times in the 
Cisco Modeling Labs client GUI, a NullPointer exception is thrown in the log file. 

Solution: None currently. 

 Symptom: SIGKILL error returned when trying to stop a simulation. (VIRLDEV-1961) 

Synopsis: Occasionally, a SIGKILL error is returned when attempting to stop a simulation. This 
happens due to inadequate system resources.  

Solution: Wait a short time and stop the simulation again. Additional system resources are also 
recommended. 

 Symptom: (OperationalError) database is locked None None: error is returned. (VIRLDEV-2212) 

Synopsis: This error is returned when there inadequate system resources to run the simulation. 

Solution: Restart the simulation. Additional system resources are also recommended. 
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 Symptom: AutoNetkit: Custom configuration lines are not applied to IOSvL2 instances. 
(VIRLDEV-2214) 

Synopsis: When a custom configuration string is applied to an IOSvL2 node and the .virl file is passed 
to AutoNetkit for processing, the configuration line is not inserted into the configuration. This 
happens due to inadequate system resources.  

Solution: Retry the configuration update again. Additional system resources are also recommended. 

 Symptom: AutoNetkit: ASN displayed twice. (VIRLDEV-2257) 

Synopsis: In AutoNetkit visualization, the tooltip displays ASN information twice. 

Solution: None currently. 

 Symptom: Title in the tab shows "null" while attaching a server to its VNC. (VIRLDEV-2258) 

Synopsis: When you attach a server to its VNC, the title in the tab of the resulting VNC console 
shows “null: VNC Console”.  

Solution: None currently. 

 Symptom: Launching a simulation with a time limit dialog ignores the second digit if the maximum 
limit is exceeded. (VIRLDEV-2259) 

Synopsis: When the Launch simulation (with time limit) option is selected and a double digit time 
limit is provided that exceeds the maximum time limit, the second digit disappears and the time 
limit get updated to a single digit in the dialog.  

Solution: None currently. 

 Symptom: CSR1000v 3.16: Error %Error opening tftp://255.255.255.255/csr1000v-1-confg (Timed 
out) thrown during boot up. (VIRLDEV-2264) 

 

Synopsis: This error message is related to the default service configuration option of Cisco IOS, 
which attempts to access the service configuration files from the tftp server.  

Solution: Log in to the CSR1000v image, go to enable and then config mode and enter the following 
command:  no service config 
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 Symptom: No valid host nova error returned. (VIRLDEV-2273) 

Synopsis: Intermittently, when launching a simulation, a no valid host nova errors and maximum 
attempts reached neutron errors are returned. 

Solution: Restart the simulation. Additional system resources are also recommended. 

 Symptom: Cannot connect to CSR1000v console. (VIRLDEV-2329) 

Synopsis: When attempting to connect to a CSR1000v console, the connection times out. 
Occasionally when a connection is established, no prompt is returned in the console. This primarily 
affects topologies with a large number of CSR1000v nodes and is due to lack of available resources 
on the server at the time.  

Solution: Additional system resources are recommended. 

 Symptom: The .virl file includes node subtypes that do not appear in the Cisco Modeling Labs 
client GUI that is installed.  
Synopsis: When a node subtype that is not listed in the GUI appears in a topology, for example, 
using an IOS XRv router when the IOS XRv image is not installed, when you launch the simulation, 
the launch will fail because it does not recognize the node subtype. This can happen when someone 
shared a .virl file with you and it includes node subtypes that you do not currently have set up in the 
client GUI.  

 
Solution: Verify with your system administrator that the Cisco Modeling Labs server you are 
connected to supports the node subtypes you need. If so, download the node subtypes to the client 
GUI by doing the following:  
Choose File > Preferences > Node Subtypes from the client UI and click Fetch from Server. 
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CML 1.0/1.0.1 Resolved Issues 
The following list of CML 1.0 and CML 1.0.1 defects are resolved in this version of CML1.1: 
 
• Symptom: A topology diagram with more than one link between a pair of nodes results in an error 

stating “Internal Server Error”.  
 
• Symptom: A topology contains two nodes. When AutoNetkit is used, the nodes are not visible in the 

network visualization. 
  
• Symptom: Resetting Interface Properties fields for IPv4/IPv6/Subnet Mask results in an error.  
 
• Symptom: AutoNetkit does not support IPv6 addressing for MPLS VPNs  
 
• Symptom: The multipoint connection icon does not retain its position when placed on the canvas or 

geographical map. Instead, it repositions itself automatically, even when specific coordinates are 
defined in the geographical map Input Geographical Location dialog box.  
Note: The multipoint connection has been replaced with the unmanaged switch. 

• Symptom: Modifying the settings.ini file during or after the installation is complete can have 
adverse effects and leave the server in a non-recoverable state, requiring a reinstallation of the 
entire OVA.  

 
• Symptom: Extract configuration takes too long and fails. 

 
• Symptom: AutoNetkit will not create configurations for parallel links. 
 
• Symptom: AutoNetkit does not support IPv6 addressing for MPLS VPNs.  

 


	What’s New?
	Platform Reference Model VMs
	New Features
	Changes
	 VMWare ESXi 5.1/5.5
	 Ubuntu Linux Server

	Caveats
	CML 1.0/1.0.1 Resolved Issues

